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[bookmark: _Toc332732005]Introduction
What is the Internet?  Sometimes it seems like magic, but it is really just a series of connected computers.  
The Internet is a worldwide collection of computer networks, meaning computers cooperating with each other to exchange data using a common software standard. Through cable lines, wireless connections and satellite links, Internet users can share information in a variety of forms. The size, scope and design of the Internet allow users to: 
· connect easily through ordinary personal computers and wireless devices; 
· exchange electronic mail (E-mail) with friends and colleagues; 
· post information for others to access, and update it frequently; 
· access multimedia information that includes sound, photographic images and even video; 
	and 
· access diverse perspectives from around the world. 
The Internet is a worldwide network of computers, using a common protocol or international standard (usually TCP/IP or Transmission Control Protocol/Internet Protocol) to communicate with each other. These computers possess software to provide or "serve" information and/or to request and see information. Academic, commercial, governmental, and military networks are part of the Internet. No one owns the Internet. When you connect your computer to the Internet you are a part of the Internet.


[bookmark: _Toc332732006]Basic Skills
These are the basic skills you should learn about the Internet:
1. Identify an Internet Service Provider and identify the main options for connecting to the internet: Dial-up, High Speed (cable or DSL), or wireless connection.
2. Identify commonly used browsers (Internet Explorer, Firefox, Chrome, Safari) and demonstrate knowledge of function.
3. Identify the address bar and enter a URL address.
4. Identify a website.
5. Identify a homepage.
6. Identify the following browser toolbar buttons and demonstrate the ability to use them: home, refresh, stop, back, forward
7. Use scroll bars to view different portions of webpages
8. Identify a hyperlink and demonstrate the ability to use a hyperlink to access other webpages.
9. Create a new tab, open a webpage in a tab, and move between tabs.
10. Enlarge the displayed text size
11. Fill out an online form.
12. Correctly enter CAPTCHA security codes.
13. Use zoom function to enlarge image (CTRL+ or CTRL-)
14. Identify search engines (Google, Yahoo!, Bing) and enter search terms into the search engine.
15. Identify pop-up windows and close them.
16. Identify pop up windows have been blocked and enable individual pop up windows as needed
17. Identify common domain types: com, org, gov, edu.
18. Demonstrate knowledge that there are ways to increase Internet safety for children.
19. Identify antivirus software providers and function of antivirus software (Norton, McAfee, AVG).
20. Avoid providing personal or financial information unless on a secured website (https://)


Important Words
	
[image: realitycheck.png] 

Website
	A website contains information that anyone can create and put on the Internet. A website can contain information on businesses, products and services, government and community services, or personal information.

	
[image: computer server2.jpg]

Web Server
	A web server is a special computer that contains the information for websites.

When you use web browser software on your local computer, a request is sent to a web server to bring back a copy of a specific website to display on your local computer.

Web servers are located all over the world.

	
InternetServer
Server
Server

	The Internet is the group of computers-- located all over the world -- that share information with each other.

	
Server

The World Wide Web

	The World Wide Web is the software behind the Internet – and a standardized way of creating website addresses that makes it easy to find information on the Internet computers located all over the world.


	

Examples of URLs include:
www.minnesotaworks.net/feedback.aspx
www.careeronestop.org/explorecareers/explorecareers.aspx
www.iseek.org/careers/realitycheck.html

Uniform Resource Locator (URL)
	
A Uniform Resource Locator is a fancy name for webpage addresses on the Internet. Just like houses have unique addresses, so do websites. 



	
	













	
[image: ]

Hyperlink
	


A hyperlink is a clickable link on a web page that takes you to another web page or opens a document.

Hyperlinks are usually words written in blue, like the four links circled here.

	
[image: search_window1.PNG]
Web Browser
	You must use web browser software on your local computer to display a web page from the Internet.

Common web browsers include: Microsoft Internet Explorer, Mozilla Firefox, Apple Safari and Google Chrome. These are not the only browsers available. You can download new browsers from the Internet or install them from a CD.

	
http://www.minnesotaworks.net 
http:// www.iseek.org 
http:// www.positivelyminnesota.com 
http:// www.careeronestop.org

Domain Name
	A Domain Name is the actual name of the website. There are common standards that a Domain Name will follow.

There can be many other pages as part of a domain name. Those pages will each have their own URL. Like this:
http://www.iseek.org/careers/assessyourself.html
or
http://www.iseek.org/careers/setgoals.html
 




[bookmark: _Toc332732007]Internet Service Providers

An Internet Service Provider (ISP) is an organization that provides access to the Internet. The main consumer Internet Service Providers are for profit companies that fall into three basic categories:  
· Phone Companies – Dial-Up or Digital Subscriber Lines (DSL).
· Cable Companies – Using the same infrastructure that is used for cable TV.
· Wireless Companies – Cell phone providers offering 3G and 4G access from a smart phone, tablet or mobile Hotspot.
Many people also use Wireless Hotspots or WiFi to connect to the Internet. Wireless Hotspots are a local wireless connection allows a user to connect to an ISP, which then connects them to the Internet.  
[bookmark: _Toc332732008]Exercise
Can you name some of your local ISPs? Discuss the merits of each with your classmates. 
[bookmark: _Toc332732009]HTML
HTML stands for Hypertext Markup Language and it is the standard computer language used on the World Wide Web. The HTML code tells browsers (such as Internet Explorer, Firefox, Chrome, and Safari) how Web pages should be presented. Web browsers then let you see the Web page content.
[bookmark: _Toc332732010]URL – Uniform or Universal Resource Locators & Domain Names

In order to find a page or site you need to have the address or location. These addresses are called Uniform or Universal Resource Locators (URLs). URLs are sometimes referred to as domain names because the system that converts the text of a URL into the address of a computer is called the Domain Name System (DNS). Domains or URLs frequently take the form of www.organizationname.com (e.g. www.google.com) but can use other formats as well. Country codes are another popular URL ending.
The right most part of a URL is the top level domain name, here are some examples that are commonly used around the world.
[image: Illustration of a map indicating primary domain names and locations]
	.com, .net & .org
	Open for registration by anyone

	.gov
	Reserved for US government agencies

	.mil
	Reserved for US military

	.edu
	Reserved for accredited educational intuitions (school & universities) 

	Country codes .ca, .co.uk, .tv, etc
	Registration varies by country. 
The .tv domain belongs to the country to Tuvalu but anyone may register one for a premium price. 
To register a Canadian .ca domain you must either be a Canadian citizen or be physically doing business in Canada.



[bookmark: _Toc320187385][bookmark: _Toc320187386]

[bookmark: _Toc332732011]Internet Browser	

An Internet Browser or Web Browser is an Application used to view Web Sites or Pages stored on other computers connected to the Internet. The most common method of browsing is called the Hyper Text Transfer Protocol (HTTP) which uses a series of Hyperlinks (sometimes just called links) to connect pages together.  
[bookmark: _Toc332732012]Common Browsers: 
[image: C:\Users\enduser\Documents\Computer Course\Internet\explorer.png]
Internet Explorer – Produced by Microsoft and bundled with the Windows operating system; uses a blue ‘e’ for the icon.
[image: C:\Users\enduser\Documents\Computer Course\Internet\firefox.png]
Firefox – Produced by Mozilla it is an open-source project based on the Netscape browser; uses a reddish orange fox circling the globe for the icon. 
[image: C:\Users\enduser\Documents\Computer Course\Internet\chrome.png]
Chrome – Produced by Google it is one of the fastest and most secure browsers available today; uses a red, yellow, green and blue orb for the icon. 
[image: C:\Users\enduser\Documents\Computer Course\Internet\safari.png]
Safari – Produced by Apple and bundled with Mac OS; uses a compass for the icon. 
[bookmark: _Toc320187387][bookmark: _Toc332732013]The address bar	 

The address bar is where you type a URL (address) into a web browser. Many browsers will bring up a search page automatically. This auto-loaded page is called a home page or start page and can be customized. 
Here are examples of the address and menu bars in the three most popular Windows browsers. They look slightly different in different operation systems. From top to bottom: Chrome, Firefox, Internet Explorer (First in Windows 7 then in Windows XP). 
Windows 7
[image: C:\Users\enduser\Documents\Computer Course\Win7\address bars.png]
Windows XP
[image: C:\Users\enduser\Documents\Computer Course\XP\address bars xp.png]
An addition to address bar,s Firefox and internet Explorer also have search boxes. Google integrated their web search functions into the address bar of Chrome. If you are unsure of the address or URL of the site you are looking for, type a few keywords into the address bar to perform a web search.  
[bookmark: _Toc320187388]

[bookmark: _Toc332732014]Internet Explorer (IE) 7/8 Overview 
[image: ]Below is a picture of the Internet Explorer window with important components highlighted. 

Note: If the Menu Bar (File, Edit, etc.) disappears completely, you can restore the menu bar by clicking on the Tools button and making sure that the Menu Bar is checked.
	URL of current webpage
[image: URL]

	The Internet Explorer 7 window displays a home page upon launch. The URL (Universal Resource Locator) is the address of the webpage being viewed. Each webpage has its own unique URL. Some URLs are case-sensitive and all have to be typed exactly, including spaces or special symbols such as ~.

	Navigate Backwards and Forwards 
[image: Navigate]
	The Back button lets you return to the last webpage that you visited. If you click on the downward facing triangle to the right of the button, you can see a menu of webpages you have visited. 

	Reload and Stop Load Buttons 
[image: Load]
	When displaying a webpage, IE transfers a copy of the webpage from the Internet onto your computer. Therefore if the webpage changes, you can update the webpage in your browser window by clicking the Reload button with the green arrows. If the webpage is taking too long to load, you can stop the process by clicking on the Stop button with the red X. Click on the Reload button to start the loading process again from the beginning.

	Home Button 
[image: Home]
	The Home button lets you return to the home page that you set. You can change the home page

	Search Engine / Search Provider [image: Search]
	You can type in a word or a phrase to search the Internet. Putting a phrase in quotes will search for that exact phrase. You can change the default search engine.

	Favorites Buttons 
[image: Favorites]
	In order to save the webpage URL link for future web browsing sessions, you must save it as a bookmark by clicking on the Add Favorites button[image: Add Favorites]. Clicking on the View Favorites button [image: View Favorites], allows you to see all your favorites you have saved. You can also export and import bookmarks.

	Tab Browsing Features
[image: Tab]
	The Tab Bar allows you to have multiple webpages open at once in a single window. Each webpage will appear under a separate tab and you can simply click on the tab to access that webpage.


	[image: ]

Checkboxes
	A checkbox lets you know you can select more than one choice from a list.

	[image: ]
Radio buttons
	A radio button lets you know you can only make one choice from a group of choices.

	[image: ]

Text entry boxes
	Boxes that allow you to type text into them on the computer screen.

	[image: Vertical Scroll.JPG]

Scrollbars
	When a graphic or window is too big to display all at one time on the screen, you can reposition – move it – up and down or sideways on the screen using scrollbars.



[bookmark: _Toc320187382][bookmark: tabs]

[bookmark: _Toc332732015]Tabbed browsing 
· Tabbed browsing allows users to open multiple websites in one Internet Explorer window by clicking on the open New Tab button or pressing CTRL+T. 
· Users can preview thumbnail images of all open tabs in a single view, by clicking on the Quick Tab button (also see screenshot below).

[image: ]
· The Add Tab Group to Favorites feature allows users to save multiple tabbed windows into one favorite tab group. For example, a user may have ten tabs open and instead of saving each tab one-by-one, she can save them all at once into one group. Click on the add favorites star icon [image: Add Favorites]and select Add Tab Group to Favorites. Then next to Tab Group Name, type in a name (e.g. Typing Websites). Finally, click Add. 
[image: Favorites tab]
 

[bookmark: changehomepage]

[bookmark: _Toc332732016]To change your home page

Your home page is displayed when Internet Explorer first opens or when you click the Home button. You can choose any webpage to be your home page.

Option 1 
1. Open Internet Explorer and go to the webpage you want to use as the home page. 
2. Click the down arrow to the right of the Home button [image: Home button], and then click Add or Change home page. 
3. In the Add or Change Home Page dialog box, click Use this webpage as your only home page. 
4. Click Yes to save your changes. 
Option 2
1. Go to Tools and select Internet Options. 
2. In the General tab, under the Home page category, type in the URL you wish to be your home page (e.g. http://www.wellesley.edu). 
3. Click Apply to save your changes. Click OK. 
[bookmark: searchengine][bookmark: _Toc332732017]
Adding a new search engine/ search provider
Internet Explorer and other search engines such as Firefox and Chrome are applications that display webpages. Search engines are free software on the internet. Different search engines will provide you with different results. Since Internet Explorer is a Microsoft product the default search engine is Microsoft’s Bing. Other popular search engines include Google, Yahoo!, DuckDuckGo and Ask.com.
To change the default search engine in Internet Explorer 7/8:  
1. [image: Search button]Click the down arrow to the right of the Search Options button . 
2. Click Find More Providers. 
3. Click the search provider you want to add. The Add Search Provider dialog box will appear. 
4. If you want the provider that you just added to be used by default when searching from the Address bar or search box, select the Make this my default search provider check box. 
5. Click Add Provider. 
[bookmark: _Toc332732018]To remove a search provider (search engine) 
1. Open Internet Explorer. Click the down arrow to the right of the Search Options button. 
2. Click Change Search Defaults. 
3. Select the search provider you would like to remove. Click Remove and then click OK. 


[bookmark: _Toc332732019]Preforming a web search
Different search engines will return different search results, different numbers of search results, and will display them in different ways. The first few results are usually ‘sponsored’ links (paid advertisements). Here is an example showing the differences between a Google search and a Bing search for search term: used bicycles
Google:
[image: ]
[bookmark: restore]Bing:
[image: ]
As you can probably tell many of the ads for this search term aren’t very relevant to what you’re looking for. Walmart doesn’t sell used bicycles. Ask.com doesn’t sell used bicycles and is probably just trying to get you to use their search engine. Once you get past the ads most search engines should provide useful results. If you can’t find what you’re looking for in the first few pages of search results you should try narrowing your search by adding more search terms. Used bicycles is a very broad search term so adding the location (city, state) of where you want to find used bicycles should provide fewer, more relevant results. 
This time the search term was: used bicycles Minneapolis Minnesota
Google:
[image: ]
The search returned 2.31 Million results compared to the 74.4 Million. There is also an interactive map showing locations of used bicycle stores in Minneapolis.


Bing:
[image: ]
Bing automatically changed the search term from ‘bicycles’ to ‘bike’ in order to provide more relevant results.  Again there are fewer search results (10.6 Million instead of 515 Million) and the top results are more relevant. 
[bookmark: _Toc332732020]Protecting yourself on the Internet
The Internet can be a great tool, but there are risks as well. Computer viruses and identity theft are real, ongoing threats. The best way to prevent either of these is to only visit trusted sites and have up-to-date anti-virus software installed on your computer. In the web search examples you may have noticed this symbol [image: ]. It signifies that the web page is safe to visit and is provided as a free service as part of AVG Anti-Virus FREE Edition (download at http://free.avg.com). Microsoft also provides free internet protection and anti-virus software in the form of  Windows® Defender (http://www.microsoft.com/windows/products/winfamily/defender/sysreq.mspx) and Microsoft Security Essentials (http://windows.microsoft.com/en-US/windows/products/security-essentials). There are many other paid and free internet security and anti-virus applications, but one of these is a good place to start. 
[bookmark: _Toc332732021]HTTPS://
When entering personal information you should always check the address bar to see if you are connected via an encrypted (secure) connection. The address of websites with a secure connection will use https:// at the beginning, the additional S standing for secure. Most browsers will also show a lock symbol near the address bar when a secure connection has been established. In Internet Explorer 7/8 it is to the left of the address and looks like this [image: ].
[bookmark: _Toc332732022]Creating Accounts
Many websites will ask you to create an account in order to use their full functionality. This will usually require to you create a username to login with and a password. Depending on the site they may also ask for other information such as your real name, address, and payment information. Be mindful of what type of information you give to sites. 
[image: ]Let’s use MinnesotaWorks.net as an example. From the URL we can tell that is automatically makes a secure connection https://www.minnesotaworks.net/ Since it is a service provided by the Minnesota Department of Employment and Economic Development we can reasonably assume that they will protect our personal information. If you click on [image: ] it will take you to page that looks like this explaining exactly why they are asking for the information and what they are going to use it for: 
If you check the boxes next to I have read the Data Privacy Notice; and I am legally eligible to work in the U.S. The site will bring up the registration from for you to fill out. 
This form uses a combination of text entry fields (for you to type information into), dropdown menus (for you to select an item from a list of choices) and radio buttons (to answer a series of yes or no questions). 
[image: ]

[image: ]
In this example you are probably safe filling out the whole form and giving them the information they have requested be weary of providing detailed personal information and payment details online. If you are going to provide personal information always look for the HTTPS:// .

[bookmark: _Toc332732023]CAPTCHA

What is a CAPTCHA? CAPTCHA stands for Completely Automated Public Turing Test to Tell Computers and Humans Apart. Many sites use CATCHAs in order to prevent computer programs (often referred to as scripts or Bots) from using them. There are many ways to implement a CAPTCHA but the most common is to use blurred words that a human can still read but even a sophisticated computer program would have trouble with. 
The below example is from TicketMaster’s website:
[image: ]
In order to continue to the next page to buy tickets you would need to type in “advehin 18acc” (the majority of CAPTCHAs used today do not count capitalization, only the correct letters/numbers in the correct order). 

TRIVIA: 
Alan Turing, whose work gave us the theoretical basis for the CAPTCHA, is considered to be the father of modern computer science and artificial intelligence. During World War II he worked for the British government deciphering German coded messages and developing secure communication systems for the Allies. 



[bookmark: _Toc332732024]More on Internet Explorer (IE) 7/8
[bookmark: _Toc332732025]Pop-up Windows
Sometimes when you click a link on a webpage it will automatically open another window. This new window is referred to as a pop-up window. Pop-up windows are traditionally associated with unwanted advertising so most modern web browsers have a built in feature to block them. In IE a bar that looks like this [image: ] will appear under the address bar when a pop-up window is blocked.
Sometimes pop-up windows are used legitimately (that is they actually contain the content you were trying to reach when you clicked on a link). If you see the pop-up blocked message and think that you want the window that was blocked simply click on the “Pop up blocked” message. A menu like this should appear:
[image: ]
Unless it is a website you visit frequently, you probably want to click the Temporarily Allow Pop-ups option. If it is a site you use often you can click Always Allow Pop-ups from this site.

[bookmark: _Toc332732026]To restore default settings in order to prevent IE crashes 
Occasionally Internet Explorer may become unstable and start constantly crashing or not working properly. Before you consider uninstalling and reinstalling Internet Explorer, you can try returning IE7 to its default settings. 
1. In Internet Explorer 7, go to Tools > Internet Options. Click the Advanced tab. (If your IE browser won't even open without crashing, you can also right-click on your IE desktop icon and select Properties and then click the Advanced tab.) 
2. Click the Reset... button near the bottom. A window will appear explaining to you what restoring your settings will do to your browser. For example, your favorite bookmarks will not be erased. Your add-ons will be disable and your temporary internet files and cookies will get erased. Most users will not notice these items are gone or can easily re-enable them later. So if your browser is unstable, we recommend that you reset your browser settings. 
3. Click Reset. 
4. You will be prompted to close and reopen your browser. 
 


Loading and Saving Webpages
[bookmark: cache][bookmark: _Toc332732027]
To empty the Temporary Internet Files folder (cache) 
Every time you visit a webpage, Internet Explorer saves a copy of the webpage to a folder called Temporary Internet Files. If this folder gets too full, Internet Explorer may run more slowly and behave in an unstable way. Also, if a webpage is not loading correctly and shows an error message (such as "Range not satisfiable..."), a common solution is to empty the cache. You should clear the cache at least once a month. 
1. In Internet Explorer, click the Tools button, and then click Internet Options. 
2. In the General tab, under Browsing history, click Delete. 
3. In the Temporary Internet Files category, click Delete files, and then click Yes. 
4. Click Close, and then click OK. 
[bookmark: historylist][bookmark: _Toc332732028]To clear the browsing history

The browsing history is a listing of all the recent websites you have visited within a set period of time (e.g. two weeks). Clearing your history list does not affect your bookmarks. 
1. In Internet Explorer, click the Tools button, and then click Internet Options. 
2. On the General tab, under Browsing history, click Delete. 
3. In the History category, click Delete history , and then click Yes. 
4. Click Close, and then click OK. 
[bookmark: savepict][bookmark: _Toc332732029]
To save a picture from a webpage
1. In Internet Explorer, using the mouse, right-click the picture you want to save. 
2. Click Save Picture As. 
3. In the Save Picture dialog box, browse to the folder where you want to save the file, and then click Save.

[bookmark: savewebpage][bookmark: _Toc332732030]To save a webpage onto your computer 
1. In Internet Explorer, go to the webpage you want to save. Click the Page button [image: Page button]and then click Save As. 
2. Navigate to the folder in which you want to save the webpage. 
3. In the File name box, type a name for the webpage. 
4. In the Save as type box, pick one of the following from the drop down menu: 
· Webpage, complete: To save all of the files needed to display this webpage, including graphics, frames, and style sheets, select Webpage, complete. This option saves each file in its original format. 
· Webpage, HTML only: To save just the current HTML webpage, click Webpage, HTML only. This option does not save individual files of images, sounds, or video onto your computer. But it does save all the HTML code information that would preserve formatting, text, hyperlinks, and the pathways to images, sounds, and video. 
· Web Archive, single file: To save all of the information needed to display this webpage in a single file, click Web Archive, single file. This option saves a snapshot of the current webpage. This option is available only if you have installed Outlook Express 5 or later. 
· Text File: To save just the text from the current webpage, click Text File. This option saves the information on the webpage in text format. 
5. Then click Save.
[bookmark: _Toc332732031]To open the webpage that you have saved 
1. Launch Internet Explorer 7. Then go to the File menu and select Open. 
2. Click on Browse to find and select the file you want to open. 
3. Click Open and then click OK. 

[bookmark: noload][bookmark: _Toc332732032]To make webpage load without images or sounds 

Loading a webpage with no images or sounds can speed up the time that it takes the webpage to load. 
1. In Internet Explorer, click the Tools button, and then click Internet Options. 
2. Click the Advanced tab. 
3. In the Settings section, under Multimedia, uncheck the boxes next to Play sounds in webpages and Show pictures. Click OK. 
Notes: To view one image without downloading the other images, right-click on the selected image and then click on Show Picture.


[bookmark: createbookmark]

Bookmarks
Bookmarks provide a permanent and easy way to remember your favorite webpage. They are only deleted when you delete them, not when you quit Internet Explorer.
[bookmark: _Toc332732033]To create bookmarks (favorites)
1. Go to the webpage you want to bookmark. 
2. Click on the Add to Favorites icon [image: Add favorites]or go to the Favorites menu. 
3. Then click on Add to Favorites. 
4. Give the webpage a name (e.g. American Revolution Prints) or keep its original name. 
5. Select the folder you would like the bookmark to reside in. 
6. Click Add. 
[bookmark: viewbookmark][bookmark: _Toc332732034]

To view and use bookmarks (favorites) 
1. In Internet Explorer, click on the View Favorites button [image: View Favorites]and select Favorites. (Another option is to click on the Favorites menu in the main toolbar.) 
2. From that list, click on the bookmark of the webpage you want to see.



[bookmark: _Toc332732035]List of shortcut keys
[bookmark: _Toc332732036]Viewing and exploring webpages
	Shortcut
	Command

	F1
	Display Help 

	F11
	Toggle between full-screen and regular views of the browser window in Internet Explorer 

	TAB
	Move forward through the items on a webpage, the Address bar, or the Links bar 

	SHFT+TAB
	Move back through the items on a webpage, the Address bar, or the Links bar 

	ALT+HOME
	Go to your home page 

	ALT+RIGHT ARROW
	Go to the next page 

	ALT+LEFT ARROW or BACKSPACE
	Go to the previous page 

	SHFT+F10
	Display a shortcut menu for a link 

	CTRL TAB or F6
	Move forward through frames and browser elements (only works if tabbed browsing is disabled) in Internet Explorer 

	CTRL+SHFT+TAB
	Move backward between frames (only works if tabbed browsing is disabled) 

	UP ARROW
	Scroll toward the beginning of a document 

	DOWN ARROW
	Scroll toward the end of a document 

	PAGE UP
	Scroll toward the beginning of a document in larger increments 

	PAGE DOWN
	Scroll toward the end of a document in larger increments 

	HOME
	Move to the beginning of a document 

	END
	Move to the end of a document in Internet Explorer 

	CTRL+F
	Find on this page 

	F5
	Refresh the current webpage 

	CTRL+F5
	Refresh the current webpage, even if the time stamp for the web version and your locally stored version are the same 

	ESC
	Stop downloading a page 

	CTRL+O
	Open a new website or page 

	CTRL+N
	Open a new window 

	CTRL+W
	Close the current window (if you only have one tab open) 

	CTRL S
	Save the current page in Internet Explorer 

	CTRL+P
	Print the current page or active frame 

	ENTER
	Activate a selected link 

	CTRL+I
	Open Favorites 

	CTRL H
	Open History in Internet Explorer 

	CTRL+J
	Open Feeds 

	ALT+P
	Open the Page menu 

	ALT+T
	Open the Tools menu 

	ALT+H
	Open the Help menu 





[bookmark: _Toc332732037]Working with Tabs
	Shortcut
	Command

	CTRL click
	Open links in a new tab in the background in Internet Explorer 

	CTRL + SHFT + click
	Open links in a new tab in the foreground 

	CTRL+T
	Open a new tab in the foreground 

	CTRL+TAB or CTRL+SHFT+TAB
	Switch between tabs 

	CTRL+W
	Close current tab (or the current window if tabbed browsing is disabled) 

	ALT+ENTER
	Open a new tab in the foreground from the Address bar 

	CTRL n (where n is a number between 1 and 8)
	Switch to a specific tab number in Internet Explorer 

	CTRL+9
	Switch to the last tab 

	CTRL+ALT+F4
	Close other tabs 

	CTRL+Q
	Toggle Quick Tabs (thumbnail view) on or off 



[bookmark: _Toc332732038]Using zoom
	Shortcut
	Command

	CTRL+PLUS SIGN
	Increase zoom (+ 10%) 

	CTRL+MINUS SIGN
	Decrease zoom (- 10%) 

	CTRL+0
	Zoom to 100% 



[bookmark: _Toc332732039]Using Search
	Shortcut
	Command

	CTRL + E
	Go to the search box in Internet Explorer 

	ALT+ENTER
	Open your search query in a new tab 

	CTRL+DOWN ARROW
	Open the search provider menu 


[bookmark: _Toc332732040]Using Print Preview
	Shortcut
	Command

	ALT P
	Set printing options and print the page in Internet Explorer 

	ALT+U
	Change paper, headers and footers, orientation, and margins for this page 

	ALT+HOME
	Display the first page to be printed 

	ALT+LEFT ARROW
	Display the previous page to be printed 

	ALT+A
	Type the number of the page you want displayed 

	ALT RIGHT ARROW
	Display the next page to be printed in Internet Explorer 

	ALT+END
	Display the last page to be printed 

	ALT+F
	Specify how you want frames to print (this option is available only if you are printing a webpage that uses frames) 

	ALT+C
	Close Print Preview 



[bookmark: _Toc332732041]Using Address bar
	Shortcut
	Command

	ALT D
	Select the text in the Address bar in Internet Explorer 

	F4
	Display a list of addresses you've typed 

	CTRL+LEFT ARROW
	When in the Address bar, move the cursor left to the next logical break in the address (period or slash) 

	CTRL+RIGHT ARROW
	When in the Address bar, move the cursor right to the next logical break in the address (period or slash) 

	CTRL+ENTER
	Add www. to the beginning and .com to the end of the text typed in the Address bar 

	UP ARROW
	Move forward through the list of AutoComplete matches 

	DOWN ARROW
	Move back through the list of AutoComplete matches in Internet Explorer 



[bookmark: _Toc332732042]Opening Internet Explorer toolbar menus
	Shortcut
	Command

	ALT+M
	Open the Home menu 

	ALT R
	Open the Print menu in Internet Explorer 

	ALT+J
	Open the RSS menu 

	ALT O
	Open the Tools menu in Internet Explorer 

	ALT+L
	Open the Help menu 



[bookmark: _Toc332732043]Working with feeds, history, and favorites
	Shortcut
	Command

	CTRL+D
	Add the current page to your favorites (or subscribe to the feed when in feed preview) 

	CTRL B
	Open the Organize Favorites dialog box in Internet Explorer 

	ALT+UP ARROW
	Move selected item up in the Favorites list in the Organize Favorites dialog box 

	ALT+DOWN ARROW
	Move selected item down in the Favorites list in the Organize Favorites dialog box 

	ALT+C
	Open Favorites Center and display your favorites 

	CTRL+H
	Open Favorites Center and display your history 

	CTRL+J
	Open Favorites Center and display your feeds 

	CTRL+SHFT+J
	Open and dock the Favorites Center and display your feeds 

	ALT+Z
	Open Add to Favorites menu (or open Subscribe to feed when in feed preview) 

	ALT A
	Open the Favorites menu from the menu bar in Internet Explorer 

	ALT+I
	Display all feeds (when in feed view) 

	ALT+M
	Mark a feed as read (when in feed view) 

	ALT+S
	Put cursor in Search box in feed view 


[bookmark: _Toc332732044]Editing
	Shortcut
	Command

	CTRL+X
	Remove the selected items and copy them to the Clipboard 

	CTRL C
	Copy the selected items to the Clipboard in Internet Explorer 

	CTRL+V
	Insert the contents of the Clipboard at the selected location 

	CTRL+A
	Select all items on the current webpage 



[bookmark: _Toc332732045]Using the information bar 
	Shortcut
	Command

	ALT + N
	Move focus to the Information bar in Internet Explorer 

	SPACEBAR
	Click the Information bar 



Portions of this section adapted from http://www.scribd.com/doc/3116372/Basic-Internet-Tutorial-1



[bookmark: _Toc332732046]Basic Internet Skills Practice
Visit these interesting and useful websites on the Internet.

Reminder: If you click a link on a webpage and want to ‘go back,’ first look to see if the page opened in a new tab at the top of the web browser. If so, you can close that tab, or just click on the previous tab to go back. If not, click the back button in the top left corner of the browser window to go back to the previous page.

[bookmark: _Toc332732047]Career and Education for Working Learners
http://www.iseek.org/
This is the Home Page for ISEEK. Go here if you want to register for a free account to save the results of your assessments and searches. NOTE: to save results in ISEEK, you must click the Save link in the upper right corner (next to the Print icon).
http://www.iseek.org/careers/skillsAssessment
This pages takes you to the ISEEK online skills assessment where you can learn which jobs match your skills. Click the gray “Get Started” button to start the assessment. 
http://www.iseek.org/careers/careergoals.html
When you set goals and build a career plan, it is easier to build your own future. The information on this page helps you set goals and build a career plan. It also gives you links to worksheets that can help you.
http://www.iseek.org/careers/realitycheck.html
This fun tool helps you learn how much money you might need to earn to pay for the lifestyle you have or want.
https://www.minnesotaworks.net/
Register for a free account where you can post your resume and search for jobs. Employers can also complete a free registration to add current job openings and look for candidates.
http://www.careeronestop.org/
You can register for free on this national job bank to search for jobs, get help exploring careers, learn what you need to know to get a better job and find schools to help you reach your goals. This site also has resume-writing and job interview help.

www.gpslifeplan.org
GPS LifePlan helps learners look at career, education, finance, leadership, and personal aspects of their life to create an action plan and help them achieve their goals. For veterans, job seekers and high school students, visit one of these URLs:
www.gpslifeplan.org/mnscumilitary
www.gpslifeplan.org/workforce
www.gpslifeplan.org/secondary

[bookmark: _Toc332732048]State and Federal Services:
[bookmark: _Toc332732049]File Online for Unemployment Insurance Benefits:
http://www.uimn.org/
Apply for unemployment insurance or check your payment status online.
[bookmark: _Toc332732050]Get Social Security Information:
http://www.socialsecurity.gov/
Learn what you need to know to replace a social security card, apply for retirement, disability and Medicare benefits.
[bookmark: _Toc332732051]Get Information for Minnesota Job Seekers, Businesses and Government:
www.positivelyminnesota.com
Get information and links about state services for Job Seekers, Businesses and Local Government. Enter a keyword (like veterans or disabilities) in the search box in the top right to help you find information.
[bookmark: _Toc332732052]Get news and information about your county in Minnesota:
http://www.mncounties.org/About_Counties/county_websites.html
Many Minnesota counties have their own government website. You can use this link to find your own county’s website. NOTE: If you retype the URL above, make sure you use the underscore _ between the words at the end so it appears as: Blind_or_Visually_Impaired. To type an underscore, press and hold the shift key while you press the hyphen key. It’s on the right side of the 0 key.
[bookmark: _Toc332732053]Find help with special services:
http://www.dhs.state.mn.us/
This link to the Minnesota Department of Human Services provides links and information on help for the aging and people with disabilities, mental health issues, alcohol and drug abuse, and many other state services. Click A-Z Topics to see the complete list of list to services and information.

Find help with special services (continued):
http://www.positivelyminnesota.com/JobSeekers/Blind_or_Visually_Impaired/
Get information about the Minnesota State Services for the Blind. NOTE: If you retype the URL above, make sure you use the underscore _ between the words at the end so it appears as: Blind_or_Visually_Impaired. To type an underscore, press and hold the shift key while you press the hyphen key. It’s on the right side of the 0 key.

http://www.positivelyminnesota.com/JobSeekers/Veterans/index.aspx
Find out about Minnesota programs for veterans.

[bookmark: _Toc332732054]Free Online Learning Sites and Adult Classes
www.bit.ly/mircmenu
This links to the Minnesota Intelligent Rural Communities digital literacy training for online basic computer skills, basic Internet skills, basic email, basic Microsoft Operating System, Basic Word Processing skills.

http://www.mnliteracy.org/hotline
The Minnesota Literacy Council’s website: Click to select the type class you want. Choose English, GED, Citizenship, Career training, College prep and more. Enter your zip code on this webpage and click the Search button to get a list of class locations in your area.

http://www.gcflearnfree.org
This is a free online learning site with many different topics to choose from.

[bookmark: _Toc332732055]Fun things to do in Minnesota:
www.exploreminnesota.com
This site is filled with fun things to do in Minnesota. Topics include:
· Arts and Culture
· Casinos and Gaming
· Amusement Parks and Zoos
· Minnesota Golf
· Tours and Excursions
· History and Science
· Outdoors and Nature
· Pro Sports
· Shopping
· Wineries and Breweries

http://www.dnr.state.mn.us/fishing/index.html
Buy a fishing license, or get information on fish and wildlife in Minnesota.

http://www.dnr.state.mn.us/camping/index.html
Find a place to go camping and make online reservations.

[bookmark: _Toc332732056]Other useful tools and services you can get to on the Internet:

http://www.publiclibraries.com/minnesota.htm
Use this site to link to public libraries across the state of Minnesota.
 
http://www.noaa.org
Get current national weather information at this site by the National Oceanic and Atmospheric Administration (NOAA). Type your zip code in the search box to get weather information for your area. Click on the radar map to see the current weather radar.

http://www.officialusa.com/stateguides/media/television/states/minnesota.html
This website gives you links to each of the websites for the Minnesota TV stations.

http://www.ontheradio.net/states/minnesota.aspx
This website gives you links to the Minnesota radio stations. Many of these websites have a button you can click to listen to the radio station on your computer.

http://maps.google.com/
Type an address or place of interest into the search bar and Google maps will zoom in on the location for you. Click “Get Directions” to get driving directions from one address to another. Play around with the arrows and zoom features on the map.

http://mspairport.com/
Visit the Minneapolis St. Paul International Airport website.













	
	Identify an Internet Service Provider and identify the main options for connecting to the internet: Dial-up, High Speed (cable or DSL), or wireless connection.

	
	Identify commonly used browsers (Internet Explorer, Firefox, Chrome, Safari) and demonstrate knowledge of function.

	
	Identify the address bar and enter a URL address.

	
	Identify a website.

	
	Identify a homepage.

	
	Identify the following browser toolbar buttons and demonstrate the ability to use them: home, refresh, stop, back, forward

	
	Use scroll bars to view different portions of webpages

	
	Identify a hyperlink and demonstrate the ability to use a hyperlink to access other webpages.

	
	Create a new tab, open a webpage in a tab, and move between tabs.

	
	Enlarge the displayed text size

	
	Fill out an online form.

	
	Correctly enter CAPTCHA security codes.

	
	Use zoom function to enlarge image (CTRL+ or CTRL-)

	
	Identify search engines (Google, Yahoo!, Bing) and enter search terms into the search engine.

	
	Identify pop-up windows and close them.

	
	Identify pop up windows have been blocked and enable individual pop up windows as needed

	
	Identify common domain types: com, org, gov, edu.

	
	Demonstrate knowledge that there are ways to increase Internet safety for children.

	
	Identify antivirus software providers and function of antivirus software (Norton, McAfee, AVG).

	
	Avoid providing personal or financial information unless on a secured website (https://)


[bookmark: _GoBack]You should now be able to do the following tasks.  Put a check mark next to the things you know how to do.



[bookmark: _Toc331104866][bookmark: _Toc332732057][image: ]What is Email? 
Email or electronic mail is a method of sending messages over the Internet. The messages travel between computers where the users have email addresses. The main advantage of email is that the messages are received within a few seconds of sending them.
Almost all businesses use email to correspond with their customers and suppliers. Most individuals who own a computer also use email for both business and personal use. It’s a great way to keep in touch with family and friends who are on holiday or living some distance away. The speed of sending and receiving email messages has made the ace of modern life very fast, as people in the workplace are often available to their managers and customers at all hours of the day and night.
There are many advantages to using email over traditional mail. The main one is speed of delivery, but cost is another important consideration. Many messages can be sent in a couple of seconds, and even with the more expensive types of Internet connection, it is still cheaper than even one postage stamp. Email messages can also carry files with them, like documents, photos, music files, etc. These files are called attachments. While you must take care not to make attachments too large in file size, there are ways of compressing them to make them easier to send. We will deal with that later.
Some of the disadvantages of email apply to regular mail as well. You are familiar with the huge amount of junk mail that comes through your mailbox each day. It is sent by people who find your address and think that you would be a good customer for their products, because of where you live, your age, or something you have bought before. Most of this junk mail you just throw away. 
In the same way, people with things to sell find email addresses and send information to them. This type of unwanted mail is called spam. Spam is more likely to contain undesirable or offensive material than paper junk mail you get at home, so you must be careful how you deal with it.
Some email providers have a service to filter out the spam that might cause offense, but some spam does get through. The best way to deal with spam is to delete the email without opening it. Spam mail can sometimes contain viruses which are activated upon opening the email.
Never reply to spam.  If you do, the sender will know that the address belongs to a real person and you will likely get more spam.

[bookmark: _Toc332732058]
Email Basic Skills
These are the basic skills you should learn about email.
1. Define: email
2. Register for new email account in online program
3. Create username and secure password
4. Log into email
5. Create an email message
6. Address an email, including to more than one recipient
7. Send an email
8. Open an email
9. Reply to only the sender of an email or to all recipients (reply all)
10. Forward an email
11. Add an attachment to an email
12. Open an attachment in an email
13. Move or delete an email and retrieve an email from the trash
14. Understand basics of email etiquette: don't use all capital letters, fill in the subject line, use appropriate greetings & closings
15. Use caution when opening an email from an unfamiliar or unexpected source and avoid opening suspicious attachments
16. Avoid giving out personal information (especially financial information) or email address to unfamiliar people
17. Identify and delete junk mail, including spam
18. Be selective and cautious about forwarding email to large groups of people
19. Define: Computer virus
20. Define and tell the difference between a URL and an email address (see World Wide Web)


[bookmark: _Toc332732059]Email Addresses
An email address is usually made up of information about the person and where they are, using the @ symbol between the two. who@where is a good way to remember the structure of an email address.Note: The terms Domain Name and URL are often used interchangeably.
The domain names used in e-mail addresses can be from a free provider such as Google, Yahoo, MSN, from an employer or personal website.

An example of an email address is:
John@gmail.com
Username
Upper level domain
Domain name



John is the name and username of the person
gmail is the domain name and the 
.com is the Top Level Domain
Sometimes the username is not an actual person’s name, but something to identify the person or people that the email is to go to. For example help@gmail.com 
www.gmail.com – This is the company website.  It does not contain an “@” sign.
john@gmail.com – This is the email address of John which is located on the same server as the company website.  An email address contains an “@” sign.
Exercise:  Email address or web site address?
Can you identify which of these is an email address and which is a web site address?
Indicate whether the address is for email or for a web site by checking the correct box after each address.

Email
Website
jane@univerisitymail.edu


University.edu


iSeek.com


Sadie95@charter.net


Universal.address@hotmail.com


teacher@school.mn.us


Careerbuilder.com










[bookmark: _Toc331104867][bookmark: _Toc332732060]How Email works
Think of email like the postal service, but instead of home delivery everyone has a post office box.  To receive email, you must have an account on a mail server.  This is similar to a post office box.  
When you send an email message, it is sent from your computer to a server (that’s like the post office). Then it is sent on to the recipients ‘post office box’ at their ‘post office.’ The message is stored in this electronic mailbox until the recipient retrieves it.  
The email server collects and stores your incoming email until the next time you open your mailbox and download the messages.  So you can access your email from any computer that is connected to the internet. 
The email is not on your computer, but is at the electronic post office called the mail server. You need a password (or a key) to access your mail box.
[bookmark: _Toc331104868]TIP: Writing email messages
Because email can be sent and received so quickly, it’s often written in a more conversational manner than a formal letter. 
An email with grammatical errors can be viewed as being “sloppy” and so you should be sure that your email is written in a manner that will be deemed appropriate by the person that reads it.
 Always double check your email before clicking the send button: use proper grammar, capitalize your I’s, and don’t use an inappropriate or angry tone. 
Don’t write in ALL CAPS.  It appears as if you are shouting. While the tone of most email is casual, it’s important to ensure your email doesn’t reflect poorly on you by the person that reads it.




[bookmark: _Toc332732061]Activity – Setup a Gmail account
[bookmark: _Toc331104869][bookmark: _Toc332732062]Step 1: Open the Gmail web site 
To create your Gmail account you only need a web browser and an internet connection. Type http://gmail.com in the address bar of your browser. You should now get to a page that looks something like the one below. 
[image: ]
Click on the Create An Account in the upper right and then proceed to the next step. 


[bookmark: _Toc331104870][bookmark: _Toc332732063]Step 2: Enter all the required information in the "Create an Account" online form 
After you click on the signup link, you should be taken to a Create an Account form with several fields that need your input. 
[image: ]
Do not worry if the screen displayed to you and the screenshot image on the above are not exactly the same. 
You now need to start filling the form. Once you have entered your first and last names, it is time to choose a login name. This is important as your login name will decide the email address you will get, and in case of a Gmail account, would be your-chosen-loginname@gmail.com. So be sure to pick a login name, also called the username, with care. 

[bookmark: _Toc331104871][bookmark: _Toc332732064]Step 3: How to choose a login name or username for your email address 
Choosing a login name is part art and part common sense, because it determines what your email address will be, so spend a little time and about it. Since email addresses need to be unique (which means no two people in the world can have the same address), there is no guarantee that your preferred login name would be available. Here are some suggestions on how to choose a login or username. 
TIP:  Choosing a user name
Your username is a reflection of you.  Choose something appropriate for professional use.  Names like “cuddlebear” and “partyanimal” will not make a good impression! Your first initial and last name might be better.  Or use a “.”  (pronounced ‘dot’) as part of your name.  For example, firstname.lastname@gmail.com.


First check if you can get a login name of your name, firstname, lastname, as firstnamelastname or the more popular, firstname.lastname (the period sign can be used in a login name). You can also try out firstnamelastname. Getting a Gmail email address of your name is indeed very fortunate because of the sheer number of subscribers to the service. Your login name needs to be catchy and at the same time describe you so people are able to recall it without much difficulty and associate it with you. 
Gmail will immediately let you know if your chosen login name is available. [image: ]
[bookmark: _Toc331104872][bookmark: _Toc332732065]Step 4: Choosing a password for your email 
You need strong password for your e-mail account is a necessity. Think of the password as the key combination to your safe and give the same amount of importance. A combination of uppercase and lowercase letters with some numbers is usually a strong enough password. Using several full words in a novel combination is also a good way to create a strong password (i.e. ‘correcthorsebatterystaple’). To the left of the text fields in which you enter your password is a sort of meter to indicate the strength of the password. 
[image: ]
You need to enter the password twice, exactly the same.
[bookmark: _Toc332732066]TIP: Be sure to record your username & password in a safe place until you’re sure you have it memorized.
Write it down!

[bookmark: _Toc331104873]
[bookmark: _Toc332732067]Step 5: Protecting your Gmail account by providing a phone number and secondary e-mail address (Optional)
Some email providers use security questions to verify your identity. Gmail now uses a phone number or secondary e-mail address verification as part of their account security. That way if you ever forget your password (or someone gets in to your account and changes it) you can verify that you are the real owner of the account. If you get a new phone number or wish to delete your secondary e-mail address you’ll be able to change it later. 
[image: ]
[bookmark: _Toc331104874][bookmark: _Toc332732068]Step 6: CAPTCHA AND confirmation 
[image: ]After providing your secondary email address - you can leave this blank, if you don't have one - and your location, you need to enter the characters that you see in the picture above the field in your form. As discussed in the Internet Basics section this is a CAPTCHA to show that you are a human being and not some automated program.
 

Now that everything is set, you can go through the Terms of Service and click on the "I accept. Create my account." button which will create your very own free Gmail account! 
[bookmark: _Toc331104875][bookmark: _Toc332732069]Logging on to Gmail
1.	Open a browser (like Internet Explorer) and type: www.gmail.com into the address box of the browser.
2.	Press Enter.TIP:  always make sure that “Stay signed in” or “remember username and password” is not checked.  If it is, anyone using that computer can open your email!

3.	Type your Gmail E-mail address in the “username” box.
4.	Type your password. 
5.	Click Sign In.


[bookmark: _Toc331104876][bookmark: _Toc332732070]Sending an e-mail
When you have created your new account it’s now time to begin sending and receiving e-mails. The examples used are from Gmail, but most e-mail programs will have similar options.
1. Select Compose Mail from the upper left hand side of the screen
[image: ]




Select Compose Mail


2. [image: ]Enter the e-mail address of the person you are sending the email to:




Enter Email Address


3. Add a subject to the Subject Field – It is very important that you enter a subject here so that the person you are sending the e-mail to has an idea what it is about. If you do not include a subject the e-mail may even be filtered out as junk when it is received.

[image: ]




4. Type your e-mail in the large, white message area.  Keep messages as short and concise and possible.

[image: ]

5. When you are finished typing your message, proofread your message before pressing Send. Your e-mail will be received after a couple of minutes. If there is a problem with the email or it does not reach the recipient, you should receive a notification email from Gmail.


[bookmark: _Toc331104877][bookmark: _Toc332732071]Opening an Email
To open a message that you receive from someone, simply click on it and it will open automatically ready for you to respond.
You will know which emails are new because the message will appear darker than emails you have already read.
[image: ]Advertisements in Gmail
Gmail is free because Google supports this service with ads displayed in the Gmail windows. It’s important to note where the advertisements are located, so as not to confuse them with the email content.





Just left click to open





How long does it take for a message to be delivered?
It may only take a few seconds for an email to be delivered. The computer sends a message through your modem (device your computer uses to access the Internet), then the email message is sent to your mail server (Gmail, for example) which sends it to the recipient’s mail server, and then the recipient’s computer receives it when s/he opens her or his mailbox. However, it occasionally takes longer than a few seconds if you are sending an email message with a large attachment, there’s congestion on the Internet, or Gmail’s servers are being heavily used.

[bookmark: _Toc331104878][bookmark: _Toc332732072]Replying to an Email
When you have opened and read an email, you may want to send a reply. All you need to do is click the reply button. This is a nice feature because you do not need to type the address of the sender. With the reply feature, it is entered automatically.
The Subject field will also be completed with Re: in front of the original subject to show you are replying to the message.
The original message will be shown in the message box and you type your reply above it. 
Then send your message in the usual way.
[image: ]
Click Reply Button


TIP: Reply vs. Reply All
Knowing the difference between “Reply” and “Reply All” can save you from embarrassment.
“Reply” sends your reply only to the original sender of the message.  “Reply All” sends your reply to everyone who received the original message.  Be careful! Sometimes you don’t want everyone to know your reply!


[image: ]Click Send
Type message




[bookmark: _Toc331104879][bookmark: _Toc332732073]Forwarding an Email
You may receive a message that you want to send to someone else. You can easily forward that message to another person.
Open the message and then click on the Forward button. This will again open the message window, and all you have to do is insert the email address of the person you wish to forward the message to. The subject field will display the original subject text with Fw: in front of it.
You can type some of your own text to explain why you are sending this email, for example “I thought you might be interested in this”.
[image: ]Select Forward


[bookmark: _Toc331104880][bookmark: _Toc332732074]
Exercise – Send an e-mailTIP: Archiving Messages
In earlier email programs, the amount of space available for emails was very limited – users had to carefully mange the amount of email that they had and delete emails that they had read. Now, space is not really a problem. Gmail allows you to save virtually every email that you receive (and makes your messages searchable). To clean up your inbox, select old emails using the boxes to the left of the messages in your inbox and then click “archive.” They will no longer show up in your inbox, but will be available when you conduct a search.


1. Compose a new e-mail. Add the e-mail of your instructor in the To: field
2. In the subject field add the text Job Goal
3. Type the following message in the main body of the e-mail:
Hi [name]:
My job goal is to become a pharmacist.
[Your name]
4. Send the e-mail



[bookmark: _Toc331104881][bookmark: _Toc332732075]Sending Attachments with Email
Email messages are really meant to be short and sweet. When you send an email, you must be careful not to make it too long. If you have a lot of information to send, you should put it into a document and “attach” it to the email. This means that the person who receives it can choose whether or not to open and read it, to save it or to delete it if they’re not interested in it. 
Attachments are also a great way to send pictures and other file types. However, you should make sure your attachments are not too large, as this can cause delays on the email system. Software like WinZip can be used to compress large files like music and photos and make it easier to send files as attachments.
[bookmark: _Toc331104882][bookmark: _Toc332732076]To send an attachment
When you have finished writing your email you can add your attachment. This may be a spread sheet, a word document, a picture file or any other type of file.
[image: ]	Left click to attach file



Then you must find the file on the computer. In this example the file has been saved to the Desktop. We must select Browse to find the file.
1. Select Browse
[image: ]
Click Browse…

2. Select area where file is saved. 
[image: ]









3. Select the file by left clicking on it.
4. Select Open. This will attach the file to the email.
5. The attachment is now ready to be sent with the email. You may now send the email or you may attach another file if you wish

[image: ]Click here if you wish to attach another file
Attached File



[bookmark: _Toc331104883][bookmark: _Toc332732077]Viewing or Saving an attachment
If you receive an attachment from someone, you may choose to use Gmail’s View option or save it to your computer and view it later. The View function in Gmail doesn’t work for all file types, so you may have save it to open it with a specific program. 
1. Open the email
2. When you see the attachment you have two options
a. View
b. Download
3. Choose Download
4. You will be prompted to Open or Save the document. Choose Save.
5. When the Save dialogue box opens choose a place to save the document.
[image: ]
Click to Download

[image: ]Choose Save File


Click OK






[image: ]Choose Location to Save File






Select Save



Your attachment will now be saved to the specified location. The anti-virus software you have installed on your computer will scan the file for viruses.

[bookmark: _Toc331104884][bookmark: _Toc332732078]Exercise – Sending email attachments

Scenario:  You are interested in applying for a job posted on www.minnesotaworks.net.  To apply, the job posting says to email your resume.  
1. Compose a new email message to your instructor, pretending you are applying for a job.  The subject should be the job title.
2. Write a short message stating two things:  1) What job you are applying for (often the job posting has a job number listed in addition to the job title), and 2) an overview of your qualifications for the job. Be sure you thank the recipient at the end of your message and mention that your resume is attached!
3. Attach your resume.
4. Proofread your message before you hit send!




[bookmark: _Toc331104885][bookmark: _Toc332732079]Managing your e-mail
It is a good idea to add friends, family or business e-mails to contacts. As well as storing e-mail addresses, adding contacts allows us to add more information about a person such as phone numbers, addresses and even birthdays and any other pieces of information to add a personal touch. In this way our e-mail program can also act as an address book and diary.
[bookmark: _Toc331104886][bookmark: _Toc332732080]Creating contacts
To create a contact:
1. Click Contacts along the left side of any page.
2. Click the New Contact [image: mail_8933_contact_button_en]button in the top-left corner of the Contact Manager. 
3. Enter your contact's information in the appropriate fields.
4. Click Save to add your contact.
You can enter additional contact info by clicking More Information or by clicking the add link next to the appropriate field. Enter your contact's information in the appropriate fields and click Save. 
Email addresses are automatically added to your Contacts list each time you use the Reply, Reply to all, or Forward functions to send messages to addresses not previously stored in your Contacts list. If these addresses don't appear immediately, try waiting a few minutes or signing out of your account and signing back in. "Also, each time you mark a message as 'Not Spam,' your Contacts list is automatically updated so that future messages from that sender are received in your inbox.
[bookmark: _Toc331104887][bookmark: _Toc332732081]Editing contacts
Sometimes we may need to update information about our contacts such as if they change e-mail address, phone no or street address. Sometimes we may also need to delete a contact we no longer use.
To edit or delete a contact, open your Contacts list by clicking Contacts on the side of any page, and following the appropriate instructions below. 
[bookmark: _Toc331104888][bookmark: _Toc332732082]To edit a contact: 
1. Select the contact in the Contacts list. 
2. Click Edit at the top of the page. 
3. Make your desired changes. 
4. Click Save at the top of the page. 

[bookmark: _Toc331104889][bookmark: _Toc332732083]To permanently delete a contact: 
1. Select the contact in the Contacts list. 
2. Click Delete Contact at the top of the page. 
3. Click OK. 


[bookmark: _Toc331104890][bookmark: _Toc332732084]Accessing your contacts when sending an e-mail
You do not need to type the e-mail address of a person you have added to contacts each time you send an e-mail. Simply start typing the person’s name or e-mail address in the To: field and a list of similar names in your Contacts should appear. 
Choosing your contacts in this way saves time and effort of trying to remember e-mail addresses. You can only use this feature when you have added people to contacts.
Note: If you are on an older computer or using the HTML only version of Gmail you’ll need to click the To: link beside the To: field (as shown below). This will show a list of your contacts from which you simply select the contact or contacts you are looking for.




[image: ][image: ]

Select To: Field




Choose your contact from the list





Choose your contact from the list

[bookmark: _Toc331104891][bookmark: _Toc332732085]Organizing your e-mails
Over time we may send and receive many hundreds of e-mails. This can make it very difficult to find a particular e-mail if we have to search our Inbox each time. Say you have booked a flight online and you have received an e-mail confirming your flight details. You do not want to waste your time searching your Inbox for that e-mail every time you need to check your details. This is why it is a good idea to organize your e-mails with Labels.
An example of a Label could be a work contact, a friend or a company you regularly purchase goods from. Once you create a label for a contact you can store all e-mails from a contact under that label, allowing you to find e-mails from that person more easily. This is similar to creating a folder to store e-mails. You can create many labels for different contacts.
[bookmark: _Toc331104892][bookmark: _Toc332732086]To create a label: 
1. Click the Labels drop-down menu or if you have keyboard shortcuts enabled, type l. Or, just click Settings > Labels. 
2. Select Create new.
3. Type the name of your new label and click Ok

Any selected messages will automatically be categorized under your new label. 
To apply a label to a message, you can click the checkbox to the left of the message(s) in question, and then select the label name from the Labels drop-down menu (or you can label a single message while you're reading it by using the drop-down menu or the keyboard shortcut L). You can also drag a message to a label's name to move that message to a label.
[bookmark: _Toc331104893][bookmark: _Toc332732087]To edit a label name: 
1. Click the down-arrow to the left of the label.
2. Select Rename.
3. Enter the new label name, and click OK. 
All the messages categorized under your old label name will now be categorized under your new label. 
[bookmark: _Toc331104894][bookmark: _Toc332732088]Organizing and deleting labels
You can control which labels appear in your list on the left.
1. Click Settings > Labels
2. Click the show or hide link next to each label to choose whether it's listed. Or, if you see a label you don't need anymore, you can always click remove.




[bookmark: _Toc331104895][bookmark: _Toc332732089]Personalizing your e-mail
If you like, you can add a personal touch to your e-mail such as adding a picture of yourself to your e-mails or adding an e-mail signature. 
[bookmark: _Toc331104896][bookmark: _Toc332732090]To add your picture to your emails:
1. Select Settings from the top right of your Inbox
2. Under the General  Tab go to My Picture and select Select a Picture
3. Browse for the appropriate picture on your computer
4. Select Open
5. Select Apply Changes

[bookmark: _Toc331104897][bookmark: _Toc332732091]To add an e-mail signature:
1. Select Settings from the top right of your Inbox
2. Under the General tab go to Signature
3. Type in the e-mail signature you want to apply
4. Scroll down to the end of the page and select Save Changes

Portions of Email Basics adapted from http://www.scribd.com/doc/49400588/Email-Basics



You should now be able to do the following tasks.  Put a check mark next to the things you know how to do.
	
	[bookmark: _Toc320187420]Define: email	 	 	 

	
	[bookmark: _Toc320187421]Register for new email account in online program	 	 	 

	
	[bookmark: _Toc320187422]Create username and secure password	 	 	 

	
	[bookmark: _Toc320187423]Log into email	 	 	 

	
	[bookmark: _Toc320187424]Create an email message	 	 	 

	
	[bookmark: _Toc320187425]Address an email, including to more than one recipient	 	 

	
	[bookmark: _Toc320187426]Send an email	 	 	 

	
	[bookmark: _Toc320187427]Open an email	 	 	 

	
	[bookmark: _Toc320187428]Reply to only the sender of an email or to all recipients (reply al	 

	
	[bookmark: _Toc320187429]Forward an email	 	 	 

	
	[bookmark: _Toc320187430]Add an attachment to an email	 	 	 

	
	[bookmark: _Toc320187431]Open an attachment in an email	 	 	 

	
	[bookmark: _Toc320187432]Move or delete an email and retrieve an email from the trash	  

	
	[bookmark: _Toc320187433]Understand basics of email etiquette: don't use all capital letters, fill in the subject line, use appropriate greetings & closings	 	 

	
	[bookmark: _Toc320187434]Use caution when opening an email from an unfamiliar or unexpected source and avoid opening suspicious attachments	 

	
	[bookmark: _Toc320187435]Avoid giving out personal information (especially financial information) or email address to unfamiliar people	 	 	 

	
	[bookmark: _Toc320187436]Identify and delete junk mail, including spam	 	 	 

	
	[bookmark: _Toc320187437]Be selective and cautious about forwarding email to large groups of people

	
	[bookmark: _Toc320187438]Define: Computer virus	 	 	 

	
	[bookmark: _Toc320187439]Define and tell the difference between a URL and an email address (see World Wide Web)
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nesotaWorks.Net Tennessen Warning Notice

The data we are asking you to provide about yourseF is considered private data by Minnesota Statute 13.47 subdivison 2. In
order to collect and use this data we must tel you why we need the data, how we intend to use & and any consequences you
may experience f you supply the information or not.

Why we need the data

» Your Socil Security Number is requested to identfy you as a unique individual and to find wage data on you that helps
us determine how wel our services helped you.

« Demographics: age, gender, ethnicity, race, and disabity status i collcted to evaluate our performance and in some
cases to determine f you're eigible for special assstance.

» Veteran status i asked to determine f you are eigible for specil services and to evaluate our service deivery.

How we intend to use the data

In addition to analyzing this data to mprove our services, we may share information about you with other employment and
training Service providers n order to determine what services you may be eigible for and to coordinate services provided to
You. Data may be shared with federal and state entites that provide funding for workforce development services. Addtionaly,
other government entities with a legal right to this data may see your information.

Consequences to you

You can refuse to supply any or all of this information; you are not egaly required to provide any of this information to use
Minnesotaworks.net. If you don't supply enough information to create a username and password for yoursef your abilty to
use MinnesotaWorks.net il be fmited. A username and password alows for easy access to your job seeking and career
management work during repeat visits.

[ I have read the Data Privacy Notice; and

[7] 1am legally eligible to work in the U.S.
Registration Page 1 of 3
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You are currently 25% done with the registration
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You are encouraged, but not required to provide your SocialSecurity Number(SSN). We use your SSN to improve our service to you and
others. We take every precaution o ssfeguard your private data, ncluding encryption and secure dtabases. Ifyou choose not o share your
SSH plesse enter a unique nine-cigit numer beginning with the number 5. For more information plesse call 1-838-727-9683 or 631-296-2536 n
the Rinneapoliss. Paul area.

*Social Security Number

*Re-Enter Social Security Number
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Please provide your date of birth 5o we can obtain more useful labor market information. This data is not used to identify you individually but is
only used in an ageregate report.
*Birth date (WM/DD/YYYY) ,

*Where did you hear about MinnesotaWorks.net? | Please select an Option. -
*Education Select the highest level completed -
“Are you in school? Please select an option. 2
*Currently Employed? Yes, currently employed

No, not currently employed @

Yes, currently employed but received separation Notice
*Have you served in the U.S. Military? © ves, served in the U.S. Military

No, never served in the U.S. Military @
*Others eligible for Veterans Priority? © ves, eligible for Veterans Priority

No, not eligible for Veterans Priority @
*Migrant Worker or Seasonal Worker? ) ves, migrant or Seasonal Worker @

No, not a Migrant or Seasonal Worker
*Migrant Worker Status Unspecified

Registration Page 2 of 3
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Security Check

Please type both words separated by a space:
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[ Vision impaired
Help

You are forbidden from accessing this site or
purchasing tickets using automated software.

Security Check provided by reCAPTCHA
©2012 Camegie Mellon University, Al rights reserved

The Security Check allows us to:

Ensure Fair Access to Tickets
Automated programs known as "Bots” cannot read
distorted text as well as humans. The Security
Check helps prevent automated programs from
blocking other customers from getting tickets.

Digitize Books One Word at a Time
By entering the words in the box, you are also
helping to digitize books from the Internet Archive
and preserve literature that was written before the
computer age.

Provide an Audio Option for Visually Impaired
Customers

An audio option allows visually impaired customers.
to hear words/numbers that can be entered instead
of the visual challenge.
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